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Question Number : 1 Question Id : 2549896602 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What will be the result if tOGGLE cASE is applied to the word ‘Examination’ in MS-Word 2019?
Options :
1.  eXAMINATION
2.  examination
3.  Examination
4.  EXAMINATION
   
Question Number : 1 Question Id : 2549896602 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
यदि एमएस वर्ड (MS-Word) 2019 में, ‘Examination’ शब्द पर tOGGLE cASE अप्लाई किया जाता है, तो क्या परिणाम होगा?
Options :
1.  eXAMINATION

2.  examination

3.  Examination

4.  EXAMINATION

   
Question Number : 2 Question Id : 2549896781 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following keyboard short cut in MS-Excel 2019 is used to open the Formulas tab and insert, trace, and customize functions and calculations?
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Options :
1.  Alt + M
2.  Alt + H
3.  Alt + P
4.  Alt + N
   
Question Number : 2 Question Id : 2549896781 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एमएस-एक्सेल 2019 में निम्नलिखित में से किस कीबोर्ड शॉर्टकट का उपयोग फॉर्मूला टैब खोलने तथा फ़ं क्शन और गणनाओं को इंसर्ट करने, ट्रे स करने और कस्टमाइज करने के  लिए किया जाता है?
Options :
1.  Alt + M
2.  Alt + H
3.  Alt + P
4.  Alt + N
   
Question Number : 3 Question Id : 2549897095 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following services of the Internet is responsible for mappings of computer hostnames to IP addresses?
Options :
1.  Domain Name System
2.  VoIP
3.  Time services
4.  Gopher
   
Question Number : 3 Question Id : 2549897095 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
इंटरनेट की निम्नलिखित में से कौन-सी सर्विस कं प्यूटर होस्टनामों (Host names) को आईपी पते (IP Address) पर मैप करने के  लिए उत्तरदायी है?
Options :
1.  डोमेन नेम सिस्टम (Domain Name System)

2.  वॉइप (VoIP)

3.  टाइम सर्विसेज (Time services)

4.  गोफर (Gopher)
   
Question Number : 4 Question Id : 2549897226 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
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Correct Marks : 1 Wrong Marks : 0
In order to publish a file in Google Docs, the ________option is used.
Options :
1.  publish to web
2.  publish to website
3.  publish on net
4.  paste to web
   
Question Number : 4 Question Id : 2549897226 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Google Docs में किसी फाइल को पब्लिश करने के  लिए _______ विकल्प का उपयोग किया जाता है।
Options :
1.  पब्लिश टू  वेब
2.  पब्लिश टू  वेबसाइट
3.  पब्लिश ऑन नेट
4.  पेस्ट टू  वेब
   
Question Number : 5 Question Id : 2549897543 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
A ______ is a set of instructions that makes the computer perform a task.
Options :
1.  program
2.  hardware
3.  monitor
4.  system
   
Question Number : 5 Question Id : 2549897543 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
______ , इंस्ट्र क्शन का एक सेट है जो कं प्यूटर को कोई टास्क करने के  लिए प्रेरित करता है।
Options :
1.  प्रोग्राम

2.  हार्डवेयर

3.  मॉनीटर

4.  सिस्टम
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Question Number : 6 Question Id : 2549897705 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
FAT stands for ______ Allocation Table.
Options :
1.  File
2.  Frame
3.  Field
4.  Folder
   
Question Number : 6 Question Id : 2549897705 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
FAT का अर्थ ______ एलोके शन टेबल है।
Options :
1.  File (फ़ाइल)
2.  Frame (फ़्रे म)
3.  Field (फ़ील्ड)
4.  Folder (फ़ोल्डर)
   
Question Number : 7 Question Id : 2549898018 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
USSD in the context of BHIM (Bharat Interface for Money) stands for ______.
Options :
1.  Unstructured Supplementary Service Data
2.  Unreliable Supplementary Service Data
3.  User Supplementary Service Data
4.  Used Supplementary Service Data
   
Question Number : 7 Question Id : 2549898018 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
BHIM (भारत इंटरफ़े स फ़ॉर मनी) के  संदर्भ में, USSD का पूर्णरूप क्या है?
Options :
1.  Unstructured Supplementary Service Data (अनस्ट्र क्चर्ड सप्लिमेंट्री  सर्विस डेटा)
2.  Unreliable Supplementary Service Data (अनरिलाएबल सप्लिमेंट्री  सर्विस डेटा)
3.  User Supplementary Service Data (यूजर सप्लिमेंट्री  सर्विस डेटा)
4.  Used Supplementary Service Data (यूज़्ड सप्लिमेंट्री  सर्विस डेटा)

TypingWale  ·  Type karo. Seekho. Exam clear karo. Hindi Typing Software

  Free Try karo  ·  typingwale.com  

Follow us on:
YT X FB IG WA

https://typingwale.com/?utm_source=CPCT&utm_medium=CPCT+PDF&utm_campaign=CPCT+PYQ+Paper
https://www.youtube.com/@CPCTwale
https://x.com/CPCTwale
https://www.facebook.com/cpctwale
https://www.instagram.com/cpctwale/
https://whatsapp.com/channel/0029Vb76AhmAu3aOqnzcYE0y
https://typingwale.com/?utm_source=CPCT&utm_medium=CPCT+PDF&utm_campaign=CPCT+PYQ+Paper


   
Question Number : 8 Question Id : 2549898840 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The '______' World Wide Character Standard uses up to 4 bytes (32 bits) to represent each letter, number or symbol.
Options :
1.  Unicode
2.  EBCDIC (Extended Binary Coded Decimal Interchange code)
3.  ASCII (American Standard Code for Information Interchange)
4.  Extended ASCII
   
Question Number : 8 Question Id : 2549898840 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
'__________' वर्ल्ड वाइड कै रेक्टर स्टैंडर्ड (World Wide Character Standard) प्रत्येक अक्षर, संख्या या प्रतीक को दर्शाने के  लिए 4 बाइट्स (32 बिट्स) तक का उपयोग करता है।
Options :
1.  यूनिकोड (Unicode)

2.  EBCDIC (एक्स्टेंडेड बाइनरी कोडेड डेसीमल इंटरचेंज कोड)

3.  ASCII (अमेरिकन स्टैंडर्ड कोड फॉर इन्फॉर्मेशन इंटरचेंज)

4.  एक्स्टेंडेड ASCII (Extended ASCII)

   
Question Number : 9 Question Id : 2549899332 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What type of device is a scanner?
Options :
1.  Input
2.  Storage
3.  Processor
4.  Output
   
Question Number : 9 Question Id : 2549899332 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
स्कै नर किस प्रकार का उपकरण है?
Options :
1.  इनपुट

2.  स्टोरेज

3.  प्रोसेसर
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4.  आउटपुट

   
Question Number : 10 Question Id : 25498910685 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What will be the output of following formula in MS-Excel 2019?

=AND(XOR(0,1),1)
Options :
1.  TRUE
2.  FALSE
3.  2
4.  #ERROR
   
Question Number : 10 Question Id : 25498910685 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Excel 2019 में निम्नलिखित फॉर्मूले का आउटपुट क्या होगा?

=AND(XOR(0,1),1)
Options :
1.  TRUE
2.  FALSE
3.  2
4.  #ERROR
   
Question Number : 11 Question Id : 25498910739 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following wildcard characters can be used in formulas in MS-Excel 2019 while searching for sequence of characters?
Options :
1.  *
2.  #
3.  ?
4.  !
   
Question Number : 11 Question Id : 25498910739 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एमएस-एक्सेल 2019 में वर्णों के  अनुक्रम की खोज करते समय सूत्रों में निम्नलिखित में से किस वाइल्डकार्ड वर्ण का उपयोग किया जा सकता है?
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Options :
1.  *
2.  #
3.  ?
4.  !
   
Question Number : 12 Question Id : 25498910941 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In printing, which of the following is the standard measure of printed image quality?
Options :
1.  DPI
2.  DIP
3.  DPQ
4.  DQP
   
Question Number : 12 Question Id : 25498910941 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
प्रिंटिंग में, प्रिंटेड इमेज क्‍वालिटी की मानक माप निम्नलिखित में से कौन-सी है?
Options :
1.  DPI
2.  DIP
3.  DPQ
4.  DQP
   
Question Number : 13 Question Id : 25498911241 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
A device that converts sound energy into electrical energy is called:
Options :
1.  microphone
2.  headphone
3.  headset
4.  speaker
   
Question Number : 13 Question Id : 25498911241 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
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ध्वनि ऊर्जा को विद्यु त उर्जा में परिवर्तित करने वाला उपकरण निम्न में से कौन सा है?
Options :
1.  माइक्रोफोन (microphone)

2.  हेडफ़ोन (headphone)

3.  हेडसेट (headset)

4.  स्पीकर (speaker)
   
Question Number : 14 Question Id : 25498911560 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Output devices make it possible to ______.
Options :
1.  view and print data
2.  scan data
3.  input data
4.  send data
   
Question Number : 14 Question Id : 25498911560 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
आउटपुट डिवाइस ______ संभव बनाते हैं।
Options :
1.  डेटा व्यू करना और प्रिंट करना

2.  डेटा स्कै न करना

3.  डेटा इनपुट करना

4.  डेटा सेंड करना

   
Question Number : 15 Question Id : 25498913535 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
To get audio or video into a computer, we must ______ it.
Options :
1.  digitise
2.  maximise
3.  shorten
4.  highlight
   
Question Number : 15 Question Id : 25498913535 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
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Correct Marks : 1 Wrong Marks : 0
कं प्यूटर में ऑडियो या वीडियो प्राप्त करने के  लिए, हमें इसे _____ करना होगा।
Options :
1.  डिजिटाइज़ (digitise)

2.  मैक्सिमाइज़ (maximise)

3.  शॉर्टेन (shorten)

4.  हाईलाइट (highlight)
   
Question Number : 16 Question Id : 25498913581 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The hexadecimal representation of the decimal number 24 is ______.
Options :
1.  18
2.  30
3.  11000
4.  47
   
Question Number : 16 Question Id : 25498913581 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
दशमलव संख्या 24 का हेक्साडेसिमल निरूपण _______ है।
Options :
1.  18
2.  30
3.  11000
4.  47
   
Question Number : 17 Question Id : 25498913636 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Lempel-Ziv-Welch (LZW) is a:
Options :
1.  lossless data compression algorithm 
2.  lossy data compression algorithm
3.  lossless data extraction algorithm 
4.  lossy data extraction algorithm
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Question Number : 17 Question Id : 25498913636 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Lempel-Ziv-Welch (LZW) क्या है?
Options :
1.  लॉसलेस डेटा कं प्रेशन एल्गोरिथ्‍म (lossless data compression algorithm)

2.  लॉसी डेटा कं प्रेशन एल्गोरिथ्‍म (lossy data compression algorithm)

3.  लॉसलेस डेटा एक्‍सट्रै क्‍शन एल्गोरिथ्‍म (lossless data extraction algorithm)

4.  लॉसी डेटा एक्‍सट्रै क्‍शन एल्गोरिथ्‍म (lossy data extraction algorithm)
   
Question Number : 18 Question Id : 25498919043 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which file of software packages is/are responsible for dictating how the software behaves under different circumstances?
Options :
1.  Configuration files
2.  Libraries
3.  Executable programs
4.  Documentation Files
   
Question Number : 18 Question Id : 25498919043 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
सॉफ़्टवेयर पैके ज की कौन-सी फ़ाइल/फ़ाइलें यह निर्धारित करने के  लिए ज़िम्मेदार होती है/हैं कि सॉफ़्टवेयर विभिन्न परिस्थितियों में किस तरह आचरण करता है?
Options :
1.  कॉन्फ़िगरेशन फ़ाइलें (Configuration files)

2.  लाइब्रेरीज़ (Libraries)

3.  एक्जिक्युटेबल प्रोग्राम (Executable programs)

4.  डॉक्‍युमेंटेशन फ़ाइलें (Documentation files)

   
Question Number : 19 Question Id : 25498919176 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following sequences is used to remove header in MS-Word 2019 document?
Options :
1.  Select Insert > Header > Remove Header
2.  Select Insert > Header > Delete Header
3.  Select Home > Header > Remove Header
4.  Select Home > Header > Delete Header
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Question Number : 19 Question Id : 25498919176 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एमएस-वर्ड 2019 डॉक्यूमेंट में हेडर को हटाने के  लिए निम्नलिखित में से किस अनुक्रम का उपयोग किया जाता है?
Options :
1.  इन्सर्ट चुनें > हेडर > रिमूव हैडर चुनें
2.  इन्सर्ट चुनें > हेडर > डिलीट हेडर चुनें
3.  होम चुनें > हेडर > रिमूव हैडर चुनें
4.  होम चुनें > हेडर > डिलीट हेडर चुनें
   
Question Number : 20 Question Id : 25498919207 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following keyboard shortcuts in MS-Word 2019 is used to decrease the font size by 1 point?
Options :
1.  Ctrl + Left bracket ([)
2.  Ctrl + Right bracket (])
3.  Shift + Right bracket (])
4.  Shift + Left bracket ([)
   
Question Number : 20 Question Id : 25498919207 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एमएस-वर्ड 2019 में निम्नलिखित में से किस कीबोर्ड शॉर्टकट का उपयोग फ़ॉन्ट आकार को 1 अंक कम करने के  लिए किया जाता है?
Options :
1.  Ctrl + Left bracket ([) 
2.  Ctrl + Right bracket (])
3.  Shift + Right bracket (])
4.  Shift + Left bracket ([)
   
Question Number : 21 Question Id : 25498919434 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
C language supports different types of operators, which can be used with variables and constants to form expressions. Which of the following operators have right to left associativity?
Options :
1.  ?:
2.  &&
3.  ||
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4.  ^
   
Question Number : 21 Question Id : 25498919434 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
C लैंग्वेज़ विभिन्न प्रकार के  ऑपरेटरों को सपोर्ट करती है, जिनका उपयोग चर और अचर मानों वाले व्यंजक बनाने के  लिए किया जा सकता है। निम्नलिखित में से किस ऑपरेटर की साहचर्यता दाएं  से बाएं  होती
है?
Options :
1.  ?:
2.  &&
3.  ||
4.  ^
   
Question Number : 22 Question Id : 25498922026 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
______ algorithm is a symmetric key cryptographic technique to provide message authentication.
Options :
1.  MAC
2.  TAC
3.  PAC
4.  SAC
   
Question Number : 22 Question Id : 25498922026 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
______एल्गोरिथ्‍म, संदेश प्रमाणीकरण प्रदान करने के  लिए सममित कुं जी (key) वाली एक क्रिप्टोग्राफिक तकनीक है।
Options :
1.  MAC
2.  TAC
3.  PAC
4.  SAC
   
Question Number : 23 Question Id : 25498922565 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
During the Mail Merge process, which of the following documents in MS-Word 2019 contains the basic text that is the same in all of the output documents?
Options :
1.  Main document
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2.  Recipient list
3.  Labels
4.  Data Source
   
Question Number : 23 Question Id : 25498922565 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
मेल मर्ज (Mail Merge) प्रोसैस के  दौरान, एमएस वर्ड (MS-Word) 2019 में, निम्न में से किस डॉक्यूमेंट में बेसिक टेक्स्ट होता है जो सभी आउटपुट डॉक्यूमेंट में समान होता है?
Options :
1.  मेन डॉक्यूमेंट (Main document)

2.  रे सिपिएं ट लिस्ट (Recipient list)

3.  लेबल (Labels)

4.  डेटा सोर्स (Data Source)

   
Question Number : 24 Question Id : 25498922613 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The OSI model consists of ____ layers.
Options :
1.  seven
2.  five
3.  eight
4.  nine
   
Question Number : 24 Question Id : 25498922613 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
OSI मॉडल में कितनी लेयर होती हैं?
Options :
1.  सात
2.  पांच
3.  आठ
4.  नौ
   
Question Number : 25 Question Id : 25498922714 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Match the columns:
 

TypingWale  ·  Type karo. Seekho. Exam clear karo. Hindi Typing Software

  Free Try karo  ·  typingwale.com  

Follow us on:
YT X FB IG WA

https://typingwale.com/?utm_source=CPCT&utm_medium=CPCT+PDF&utm_campaign=CPCT+PYQ+Paper
https://www.youtube.com/@CPCTwale
https://x.com/CPCTwale
https://www.facebook.com/cpctwale
https://www.instagram.com/cpctwale/
https://whatsapp.com/channel/0029Vb76AhmAu3aOqnzcYE0y
https://typingwale.com/?utm_source=CPCT&utm_medium=CPCT+PDF&utm_campaign=CPCT+PYQ+Paper


Topology Description
 a) Bus topology  i) Each device has a dedicated point-to-point link only to a central controller, usually called a h
 b) Ring topology  ii) Only long cable acts as a backbone to link all the devices in a network
 c) Hybrid topology  iii) Each device is linked to only its immediate neighbours (either physically or logically)
 d) Star topology  iv) You can have a main star topology with each branch connecting several stations in a bus to
Options :
1.  (a) - ii, (b) - iii, (c) - iv, (d) - i
2.  (a) - iii, (b) - ii, (c) - iv, (d) - i
3.  (a) - ii, (b) - iii, (c) - i, (d) - iv
4.  (a) - i, (b) - iii, (c) - iv, (d) - ii
   
Question Number : 25 Question Id : 25498922714 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
स्तंभों का मिलान करें :
 

 टोपोलॉजी विवरण
 a) बस टोपोलॉजी  i) प्रत्येक डिवाइस का एक समर्पित पॉइंट-टू -पॉइंट लिंक के वल एक कें द्रीय नियंत्रक से होता है, जिसे आमतौर पर
 b) रिंग टोपोलॉजी  ii) के वल एक लंबी के बल बैकबोन के  रूप में कार्य करती है जो नेटवर्क  में सभी डिवाइसों को जोड़ती है
 c) हाइब्रिड टोपोलॉजी   iii) प्रत्येक डिवाइस के वल अपने निकटतम पड़ोसियों से जुड़ा होता है (भौतिक या तार्कि क रूप से)
 d) स्टार टोपोलॉजी  iv) आप एक मुख्य स्टार टोपोलॉजी रख सकते हैं जिसमें प्रत्येक शाखा कई स्टेशनों को बस टोपोलॉजी में जोड़ती 
Options :
1.  (a) - ii, (b) - iii, (c) - iv, (d) - i
2.  (a) - iii, (b) - ii, (c) - iv, (d) - i
3.  (a) - ii, (b) - iii, (c) - i, (d) - iv
4.  (a) - i, (b) - iii, (c) - iv, (d) - ii
   
Question Number : 26 Question Id : 25498924466 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following refers to the length of the longest of all shortest paths between any two nodes in a computer network?
Options :
1.  Network diameter
2.  Network radius
3.  Network range
4.  Network area
   
Question Number : 26 Question Id : 25498924466 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes

TypingWale  ·  Type karo. Seekho. Exam clear karo. Hindi Typing Software

  Free Try karo  ·  typingwale.com  

Follow us on:
YT X FB IG WA

https://typingwale.com/?utm_source=CPCT&utm_medium=CPCT+PDF&utm_campaign=CPCT+PYQ+Paper
https://www.youtube.com/@CPCTwale
https://x.com/CPCTwale
https://www.facebook.com/cpctwale
https://www.instagram.com/cpctwale/
https://whatsapp.com/channel/0029Vb76AhmAu3aOqnzcYE0y
https://typingwale.com/?utm_source=CPCT&utm_medium=CPCT+PDF&utm_campaign=CPCT+PYQ+Paper


Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से कौन एक कं प्यूटर नेटवर्क  में किन्हीं  दो नोड्स के  बीच सभी सबसे छोटे पथों की लंबाई को संदर्भित करता है?
Options :
1.  नेटवर्क  व्यास (Network diameter)

2.  नेटवर्क  त्रिज्या (Network radius)

3.  नेटवर्क  रेंज (Network range)

4.  नेटवर्क  क्षेत्र (Network area)
   
Question Number : 27 Question Id : 25498924512 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following extensions is used for a zipped file?
Options :
1.  .zip
2.  .jip
3.  .zig
4.  .zippo
   
Question Number : 27 Question Id : 25498924512 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
जिप की गई (Zipped) फाइल के  लिए निम्नलिखित में से किस एक्सटेंशन का उपयोग किया जाता है?
Options :
1.  .zip
2.  .jip
3.  .zig
4.  .zippo
   
Question Number : 28 Question Id : 25498924608 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What is a JBF file?
Options :
1.  Paint Shop Pro Browser Cache Format File
2.  System File
3.  Compressed Archive File
4.  MS fast find file
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Question Number : 28 Question Id : 25498924608 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
JBF फ़ाइल क्या होती है?
Options :
1.  पेंट शॉप प्रो ब्राउजर कै श फॉर्मेट फ़ाइल (Paint Shop Pro Browser Cache Format File)

2.  सिस्टम फ़ाइल (System File)

3.  कम्प्रेस्ड आर्काइव फ़ाइल (Compressed Archive File)

4.  MS फास्ट फाइंड फ़ाइल (MS fast find file)
   
Question Number : 29 Question Id : 25498925225 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following protocols describes how to make and receive phone calls over the internet?
Options :
1.  VoIP
2.  IRC
3.  List Server
4.  Telnet
   
Question Number : 29 Question Id : 25498925225 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से कौन सा प्रोटोकॉल बताता है कि इंटरनेट पर फ़ोन कॉल कै से करें  और प्राप्त करें?
Options :
1.  VoIP
2.  IRC

3.  लिस्ट सर्वर (List Server)

4.  टेलनेट (Telnet)
   
Question Number : 30 Question Id : 25498925253 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is not an essential component for connecting to the Internet?
Options :
1.  Printer
2.  ISP
3.  Modem
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4.  Router
   
Question Number : 30 Question Id : 25498925253 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से कौन सा इंटरनेट से जुड़ने के  लिए एक आवश्यक घटक नहीं  है?
Options :
1.  प्रिंटर (Printer)

2.  आईएसपी (ISP)

3.  मॉडेम (Modem)

4.  राऊटर (Router)
   
Question Number : 31 Question Id : 25498925303 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which group of Home tab has the option to change the alignment of text in MS-Word 2019 document?
Options :
1.  Paragraph
2.  View
3.  Tools
4.  Edit
   
Question Number : 31 Question Id : 25498925303 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
होम टैब के  किस समूह में MS-Word 2019 दस्तावेज़ में टेक्स्ट के  संरेखण (Alignment) को बदलने का विकल्प है?
Options :
1.  पैराग्राफ
2.  व्‍यू
3.  टू ल्स
4.  एडिट
   
Question Number : 32 Question Id : 25498925412 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
_____________ is essentially a back-up battery for your computer system in the event of a power failure or other electrical problems.
Options :
1.  Uninterruptible power supply
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2.  Unified power supply
3.  Uninterruptible power sink
4.  Universal power sink
   
Question Number : 32 Question Id : 25498925412 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
विद्यु त् विफलता या अन्य विद्यु त् समस्याओं की स्थिति में, ______ आपके  कं प्यूटर सिस्टम के  लिए एक आवश्‍यक बैक-अप बैटरी है।
Options :
1.  अनइंटरप्टिबल पॉवर सप्लाई (Uninterruptible power supply)

2.  यूनिफ़ाइड पॉवर सप्लाई (Unified power supply)

3.  अनइंटरप्टिबल पॉवर सिंक (Uninterruptible power sink)

4.  यूनिवर्सल पॉवर सिंक (Universal power sink)
   
Question Number : 33 Question Id : 25498929859 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT a way to insert a formula in MS-Excel 2019 worksheet?
Options :
1.  Inserting a function from the Home tab
2.  Typing a formula inside the cell.
3.  Using the Insert Function option from the Formulas tab.
4.  Selecting a formula from one of the groups in the Formula tab.
   
Question Number : 33 Question Id : 25498929859 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्न में से कौन-सा, एमएस एक्सेल (MS-Excel) 2019 वर्क शीट में फ़ॉर्मूला इन्सर्ट करने का तरीका नहीं  है?
Options :
1.  होम टैब से फ़ं क्शन इन्सर्ट करना

2.  सेल के  अंदर फ़ॉर्मूला टाइप करना

3.  फ़ॉर्मूला टैब से इन्सर्ट फ़ं क्शन विकल्प का उपयोग करना

4.  फ़ॉर्मूला टैब में किसी एक ग्रुप से फ़ॉर्मूला सेलेक्‍ट करना

   
Question Number : 34 Question Id : 25498930074 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT a valid MS-Excel 2019 function?
Options :
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1.  SUMADD
2.  SUM
3.  SUMIF
4.  SUMPRODUCT
   
Question Number : 34 Question Id : 25498930074 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से कौन-सा एमएस एक्सेल (MS-Excel) 2019 फ़ं क्शन मान्य नहीं  है?
Options :
1.  SUMADD
2.  SUM
3.  SUMIF
4.  SUMPRODUCT
   
Question Number : 35 Question Id : 25498930309 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What will be the output of the MS-Excel 2019 short date formula '=DATE(2020,8,31)'?
Options :
1.  8/31/2020
2.  08/31/2020
3.  08-31-2020
4.  31.08.2020
   
Question Number : 35 Question Id : 25498930309 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एमएस एक्सेल (MS-Excel) 2019 में, शॉर्ट डेट फ़ॉर्मूला '=DATE(2020,8,31)' का आउटपुट क्या होगा?
Options :
1.  8/31/2020

2.  08/31/2020

3.  08-31-2020

4.  31.08.2020

   
Question Number : 36 Question Id : 25498930897 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is the keyboard shortcut for the ‘Save As’ option in MS-Word 2019?
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Options :
1.  F12
2.  F10
3.  F9
4.  F8
   
Question Number : 36 Question Id : 25498930897 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एमएस वर्ड (MS-Word) 2019 में, ‘Save As’ के  विकल्प के  लिए निम्न में से कौन-सा कीबोर्ड शॉर्टकट है?
Options :
1.  F12
2.  F10
3.  F9
4.  F8
   
Question Number : 37 Question Id : 25498931010 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What are the minimum and maximum zoom levels in a zoom slider of an MS-Word 2019 document?
Options :
1.  10% and 500%
2.  1% and 500%
3.  10% and 600%
4.  100% to 1000%
   
Question Number : 37 Question Id : 25498931010 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एमएस वर्ड (MS-Word) 2019 में, डॉक्युमेंट के  ज़ूम स्लाइडर में मिनिमम और मैक्सिमम ज़ूम लेवेल कितना होता है?
Options :
1.  10% और 500%

2.  1% और 500%

3.  10% और 600%

4.  100% से 1000%

   
Question Number : 38 Question Id : 25498931055 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
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Which of the following keyboard shortcuts is used to move the active cell to the first column on the current row in MS-Excel 2019?
Options :
1.  Home
2.  Ctrl + Home
3.  Page up
4.  Page down
   
Question Number : 38 Question Id : 25498931055 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एमएस एक्सेल (MS-Excel) 2019 में, एक्टिव सेल को करंट रो (row) के  पहले कॉलम (column) में ले जाने के  लिए निम्न में से किस कीबोर्ड शॉर्टकट का उपयोग किया जाता है?
Options :
1.  Home
2.  Ctrl + Home
3.  Page up
4.  Page down
   
Question Number : 39 Question Id : 25498931439 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which printer is very commonly used for desktop publishing?
Options :
1.  Laser printer
2.  Line printer
3.  Daisy wheel printer
4.  Dot matrix printer
   
Question Number : 39 Question Id : 25498931439 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
डेस्कटॉप पब्लिशिंग (desktop publishing) के  लिए किस प्रिंटर का सबसे अधिक उपयोग किया जाता है?
Options :
1.  लेजर प्रिंटर (Laser Printer)

2.  लाइन प्रिंटर (Line printer)

3.  डेज़ी व्हील प्रिंटर (Daisy wheel printer)

4.  डॉट मैट्रि क्स प्रिंटर (Dot matrix printer)

   
Question Number : 40 Question Id : 25498933786 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
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Correct Marks : 1 Wrong Marks : 0
To delete text to the left of the insertion point, press the _________ key in MS-Word document.
Options :
1.  Backspace
2.  Space
3.  Ctrl + X
4.  Escape Key
   
Question Number : 40 Question Id : 25498933786 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एमएस-वर्ड डॉक्यूमेंट में, इंसर्शन पॉइंट के  बाईं ओर टेक्स्ट को डिलीट करने के  लिए, _________ कुं जी दबाएं ।
Options :
1.  Backspace
2.  Space
3.  Ctrl + X

4.  Escape कुं जी
   
Question Number : 41 Question Id : 25498938404 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In MS-Excel 2019, a part of pie chart is known as a _________.
Options :
1.  slice
2.  pie
3.  part
4.  circle
   
Question Number : 41 Question Id : 25498938404 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Excel 2019 में, पाई चार्ट के  एक भाग को _________ के  रूप में जाना जाता है।
Options :
1.  स्लाइस (slice)

2.  पाई (pie)

3.  पार्ट (part)

4.  सर्क ल (circle)
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Question Number : 42 Question Id : 25498938504 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
When the user navigates to a webpage controlled by the spyware author, the page contains:
Options :
1.  code that attacks the browser and forces the download and installation of spyware
2.  adware to attract users
3.  key loggers
4.  security holes to grab information
   
Question Number : 42 Question Id : 25498938504 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
जब यूज़र स्पाइवेयर ऑथर द्वारा नियंत्रित वेब पेज पर जाता है, तो उस पेज में ______ ।
Options :
1.  ब्राउज़र पर अटैक करने वाला कोड होता है जो स्पाइवेयर को डाउनलोड और इन्स्टॉल करने का दबाव बनाता है
2.  यूज़र को लुभाने के  लिए ऐडवेयर होता है
3.  की लॉगर्स होते हैं
4.  सूचना प्राप्त करने के  लिए सिक्‍योरिटी होल्‍स होते हैं
   
Question Number : 43 Question Id : 25498940618 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Software quality is measured by:
Options :
1.  functional and non-functional attributes
2.  hacking
3.  cracking
4.  phishing
   
Question Number : 43 Question Id : 25498940618 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
सॉफ्टवेयर की गुणवत्ता किसके  द्वारा मापी जाती है?
Options :
1.  फं क्‍शनल और गैर-फं क्‍शनल विशेषताओं (functional and non-functional attributes) के  द्वारा
2.  हैकिं ग (hacking) के  द्वारा
3.  क्रै किं ग (cracking) के  द्वारा
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4.  फिशिंग (phishing) के  द्वारा
   
Question Number : 44 Question Id : 25498942476 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
A __________ is a grid of rows and columns in Microsoft Excel.
Options :
1.  spreadsheet
2.  page
3.  document
4.  slide
   
Question Number : 44 Question Id : 25498942476 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
__________ Microsoft Excel में पंक्तियों और स्तंभों का एक ग्रिड है।
Options :
1.  स्प्रेडशीट
2.  पेज
3.  डॉक्यूमेंट
4.  स्लाइड
   
Question Number : 45 Question Id : 25498942480 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Microsoft Excel 2019 labels columns in a spreadsheet as _______.
Options :
1.  A, B, C
2.  1, 2, 3
3.  A1, B1, C1
4.  1A, 2B, 3C
   
Question Number : 45 Question Id : 25498942480 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Microsoft Excel 2019 में, स्प्रेडशीट के  कॉलम _________ के  रूप में अंकित होते हैं।
Options :
1.  A, B, C
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2.  1, 2, 3
3.  A1, B1, C1
4.  1A, 2B, 3C
   
Question Number : 46 Question Id : 25498942484 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
To move one cell up in an Microsoft Excel spreadsheet, which of the following keys is used?
Options :
1.  Up arrow key
2.  Down arrow key
3.  Left arrow key
4.  Right arrow key or Tab key
   
Question Number : 46 Question Id : 25498942484 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
माइक्रोसॉफ्ट एक्सेल स्प्रेडशीट में एक सेल ऊपर जाने के  लिए निम्नलिखित में से किस कुं जी का उपयोग किया जाता है?
Options :
1.  अप एरो की
2.  डाउन एरो की
3.  लेफ्ट एरो की
4.  राइट एरो की या टैब की
   
Question Number : 47 Question Id : 25498942496 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Data is organised in a spreadsheet in the form of __________ in MS-Excel worksheet.
Options :
1.  rows and columns
2.  length and breadth
3.  graph only
4.  chart only
   
Question Number : 47 Question Id : 25498942496 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Excel वर्क शीट में डेटा को __________ के  रूप में एक स्प्रेडशीट में व्यवस्थित किया जाता है।
Options :
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1.  रो और कॉलम
2.  लेंथ और ब्रेथ
3.  के वल ग्राफ
4.  के वल चार्ट
   
Question Number : 48 Question Id : 25498942500 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In MS-Excel 2019, ________ is an example of relative reference.
Options :
1.  B1
2.  $B
3.  B$1
4.  $B$1
   
Question Number : 48 Question Id : 25498942500 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Excel 2019 में, ________ सापेक्ष संदर्भ (Relative Reference) का एक उदाहरण है।
Options :
1.  B1
2.  $B
3.  B$1
4.  $B$1
   
Question Number : 49 Question Id : 25498942521 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following keyboard shortcuts is used to go to the Insert tab in Microsoft Word 2019?
Options :
1.  Alt + N
2.  Alt + H
3.  Alt + F
4.  Alt + M
   
Question Number : 49 Question Id : 25498942521 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
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Microsoft Word 2019 में, इन्सर्ट टैब पर जाने के  लिए निम्नलिखित में से किस की-बोर्ड शॉर्टकट का उपयोग किया जाता है?
Options :
1.  Alt + N
2.  Alt + H
3.  Alt + F
4.  Alt + M
   
Question Number : 50 Question Id : 25498942525 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following keyboard shortcuts is used to close the Microsoft Excel?
Options :
1.  Alt + F4
2.  Alt + F1
3.  Alt + F3
4.  Alt + F5
   
Question Number : 50 Question Id : 25498942525 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Microsoft Excel को बंद करने के  लिए निम्नलिखित में से किस की-बोर्ड शॉर्टकट का उपयोग किया जाता है?
Options :
1.  Alt + F4
2.  Alt + F1
3.  Alt + F3
4.  Alt + F5
   
Question Number : 51 Question Id : 25498942541 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following keyboard shortcuts is used to get the sum of the values of adjacent cells in Microsoft Excel 2019?
Options :
1.  Alt + =
2.  Shift + =
3.  Ctrl + =
4.  Alt + −
   
Question Number : 51 Question Id : 25498942541 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
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Correct Marks : 1 Wrong Marks : 0
Microsoft Excel 2019 में, निकटस्थ सेल के  मानों का योग ज्ञात करने के  लिए निम्नलिखित में से किस की-बोर्ड शॉर्टकट का उपयोग किया जाता है?
Options :
1.  Alt + =
2.  Shift + =
3.  Ctrl + =
4.  Alt + −

   
Question Number : 52 Question Id : 25498942545 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What is the decimal equivalent of the binary number 110110?
Options :
1.  54
2.  53
3.  64
4.  51
   
Question Number : 52 Question Id : 25498942545 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
बाइनरी संख्या 110110 का दशमलव समतुल्यांक निम्न में से क्या होगा?
Options :
1.  54
2.  53
3.  64
4.  51
   
   

READING COMPREHENSION
Section Id : 2549899933
Section Number : 2
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 5
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Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549899974
Question Shuffling Allowed : No
Is Section Default? : No
   
Question Id : 25498921307 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension Questions : No Question Pattern Type :
NonMatrix
Question Numbers : (53 to 57)
Read the given passage and answer the questions that follow.

Man has always been fascinated by high mountains. They seem to challenge man by their greatness. Man accepts the challenge and despite all dangers involved, he attempts to conquer
these heights. The primary objective of a mountaineering expedition is to get to the top of a mountain which has remained unconquered. All expeditions take with them local guides who are
not only experienced climbers, but also have a thorough knowledge of the land.

Oxygen masks and other protective equipment available today are essential for any mountaineer, but what ultimately determines his success is his own stamina. The greater the height of the
mountain, the greater is the risk involved. Throughout the journey, a mountaineer has to place each step with utmost caution. Death seems to be his constant companion which can be kept at
bay only with a supreme presence of mind.

Sometimes an expedition has to be suspended because of bad weather or death of a member. However, such an expedition cannot be called a total failure because it still provides useful
information for later attempts. Every expedition takes along a team of scientists who record their observations on the weather, plants, animals, soil etc. These observations help future
climbers by providing knowledge about the conditions they might have to face.

Ordinary people should not lose heart if they do not have the courage to go on such dangerous journeys. They can go on short treks with friends or family to enjoy a waterfall or cross a
small valley. Others can simply go to a hill station and enjoy the scenic beauty and the cool weather. A visit to a hill station can provide the innocent pleasure of mountain climbing without
any risk to life or limb.
Sub questions
 
Question Number : 53 Question Id : 25498921308 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The main objective of an expedition is to:
Options :
1.  scale new peaks
2.  collect scientific data
3.  enjoy the landscape
4.  face dangers
 
Question Number : 54 Question Id : 25498921309 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Local guides are hired because they:
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Options :
1.  are familiar with the land
2.  help to carry equipment
3.  are easy to afford
4.  can predict weather
 
Question Number : 55 Question Id : 25498921310 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The success of a climber is determined by:
Options :
1.  the climber’s stamina
2.  oxygen supply
3.  favourable weather
4.  local guides
 
Question Number : 56 Question Id : 25498921311 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In order to survive, a climber must have:
Options :
1.  mental alertness
2.  a detailed map
3.  protective equipment
4.  information about the weather
 
Question Number : 57 Question Id : 25498921312 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
A visit to a hill station DOES NOT:
Options :
1.  pose a danger to one’s life
2.  fill one with a sense of adventure
3.  offer the pleasure of enjoying the scenic beauty
4.  provide people with an opportunity to go trekking

   
Question Id : 25498921307 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension Questions : No Question Pattern Type : NonMatrix
Question Numbers : (53 to 57)
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दिए गए गद्यांश को पढ़ें  और उसके  आधार पर प्रश्नों के  उत्तर दें।

मनुष्य हमेशा ऊँ चे पहाड़ों से आकर्षित रहा है। वे अपनी महानता से मनुष्य को चुनौती देते जैसे लगते हैं। मनुष्य चुनौती स्वीकार करता है और इसमें शामिल सभी खतरों के  बावजूद, वह इन ऊँ चाइयों को जीतने का
प्रयास करता है। पर्वतारोहण अभियान का प्राथमिक उद्देश्य एक पहाड़ के  शीर्ष तक पहुँचना है जो अतीत में अजेय रहा है। सभी अभियानो में स्थानीय मार्गदर्शकों को शामिल किया जाता हैं जो न के वल अनुभवी
पर्वतारोही होते हैं बल्कि वे भूमि का भी पूर्ण ज्ञान रखते हैं।

आज उपलब्ध ऑक्सीजन मास्क और अन्य सुरक्षात्मक उपकरण किसी भी पर्वतारोही के  लिए आवश्यक हैं लेकिन जो अंतत: उनकी सफलता का निर्धारण करती है वह उनकी अपनी सहनशक्ति होती है। पहाड़
की ऊँ चाई जितनी अधिक होगी जोखिम उतना ही अधिक शामिल होगा। संपूर्ण यात्रा के  दौरान, एक पर्वतारोही को प्रत्येक चरण अत्यधिक सावधानी से रखना होता है। मृत्यु उनकी निरंतर साथी लगती है जिसे
के वल मन की सर्वोच्च उपस्थिति के  साथ ही हराया जा सकता है।

कभी-कभी खराब मौसम या किसी भी सदस्य की मृत्यु के  कारण एक अभियान को रोकना पड़ता है। हालाँकि, इस तरह के  किसी अभियान को पूर्ण विफल नहीं  कहा जा सकता है क्योंकि यह अभी भी बाद के
प्रयासों के  लिए उपयोगी जानकारी प्रदान करता है। प्रत्येक अभियान में वैज्ञानिकों का एक दल साथ होता है जो मौसम, पौधों, जानवरों और मृदा आदि पर अपने अवलोकन रिकॉर्ड करते हैं। ये अवलोकन भविष्य
के  पर्वतारोहियों को उन स्थितियों के  बारे  में ज्ञान प्रदान करके  उनकी सहायता करते हैं जिनका उन्हें सामना करना पड़ सकता है।

यदि सामान्य लोगों के  पास ऐसी खतरनाक यात्राओं पर जाने का साहस नहीं  है तो उन्हें हार नहीं  माननी चाहिए। वे झरने का आनंद लेने या छोटी घाटी पार करने के  लिए दोस्तों या परिवार के  साथ छोटी ट्रे क पर जा
सकते हैं। अन्य लोग किसी हिल स्टेशन पर भी जा सकते हैं और मनोहारी सौंदर्य और ठं डे मौसम का आनंद ले सकते हैं। किसी हिल स्टेशन की एक यात्रा, जीवन या शरीर के  अंगों को जोखिम में डाले बिना
पर्वतारोहण के  निर्मल आनंद को प्रदान कर सकती है।
Sub questions
 
Question Number : 53 Question Id : 25498921308 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
किसी अभियान का मुख्य उद्देश्य निम्न में से क्या है?
Options :
1.  नई ऊँ चाइयों पर चढ़ना
2.  वैज्ञानिक आँकड़े एकत्रित करना
3.  दृश्यभूमि का आनंद लेना
4.  खतरों का सामना करना
 
Question Number : 54 Question Id : 25498921309 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
स्थानीय मार्गदर्शकों को किराए पर लिया जाता है क्योंकि वे:
Options :
1.  भूमि से परिचित होते हैं।
2.  उपकरण ले जाने में सहायता करते हैं।
3.  वहन करने में सरल होते हैं।
4.  मौसम की भविष्यवाणी कर सकते हैं।
 
Question Number : 55 Question Id : 25498921310 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
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Correct Marks : 1 Wrong Marks : 0
किसी पर्वतारोही की सफलता को निम्न में से किसके  द्वारा निर्धारित किया जाता है?
Options :
1.  पर्वतारोही की सहनशक्ति
2.  ऑक्सीजन आपूर्ति
3.  अनुकू ल मौसम
4.  स्थानीय मार्गदर्शक
 
Question Number : 56 Question Id : 25498921311 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
जीवित रहने के  लिए, एक पर्वतारोही के  पास निम्न में से क्या अवश्य होना चाहिए?
Options :
1.  मानसिक सजगता
2.  एक विस्तृत नक्शा
3.  सुरक्षात्मक उपकरण
4.  मौसम की जानकारी
 
Question Number : 57 Question Id : 25498921312 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
किसी हिल स्टेशन की यात्रा निम्न में से क्या प्रदान नहीं  करती है?
Options :
1.  जीवन के  प्रति खतरा
2.  साहस की समझ
3.  मनोहारी सौंदर्य की आनंद प्राप्ति
4.  व्‍यक्तियों के  लिए ट्रे  किं ग पर जाने का अवसर

        QUANTITATIVE APTITUDESection Id : 2549899934Section Number : 3Section type : OnlineMandatory or Optional : MandatoryNumber of Questions :
6Number of Questions to be attempted : 6Section Marks : 6Display Number Panel : YesMaximum Instruction Time : 0Sub-Section Number : 1Sub-Section Id : 2549899975Question
Shuffling Allowed : YesIs Section Default? : No    
Question Number : 58 Question Id : 25498928815 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In how many different ways can the letters of the word ‘BANKING’ be arranged?
Options :
1.  2520
2.  5040
3.  2540
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4.  5080
   
Question Number : 58 Question Id : 25498928815 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
'BANKING' शब्द के  अक्षरों को कितने अलग-अलग तरीकों से व्यवस्थित किया जा सकता है?
Options :
1.  2520
2.  5040
3.  2540
4.  5080
   
Question Number : 59 Question Id : 25498928969 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Lokesh bought an article for ₹2,500. He spent ₹320 on its shipping. He then sold it for ₹4,089. What was the percentage of profit that he gained in this transaction?
Options :
1.  45%
2.  38%
3.  46%
4.  35%
   
Question Number : 59 Question Id : 25498928969 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
लोके श ने ₹2,500 में एक वस्तु खरीदी। उसने इसकी शिपिंग पर ₹320 खर्च किए। इसके  बाद उसने इसे ₹4,089 में बेच दिया। इस लेन-देन में उसे कितने प्रतिशत लाभ प्राप्त हुआ?
Options :
1.  45%
2.  38%
3.  46%
4.  35%
   
Question Number : 60 Question Id : 25498929056 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What will come in place of the question mark (?) in the given number series?

1.5     2.5     7     24     100     ?
Options :
1.  505
2.  345
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3.  460
4.  525
   
Question Number : 60 Question Id : 25498929056 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
दी गई संख्या श्रृंखला में प्रश्न चिह्न (?) के  स्थान पर क्या आएगा?

1.5    2.5    7    24    100   ?
Options :
1.  505
2.  345
3.  460
4.  525
   
Question Number : 61 Question Id : 25498929127 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Two containers have an equal amount of a mixture of milk and water in the ratios of 4 : 3 and 5 : 2. If the contents of both containers are transferred to a third container, the ratio of milk and
water would become:
Options :
1.  9 : 5
2.  5 : 9
3.  5 : 4
4.  3 : 2
   
Question Number : 61 Question Id : 25498929127 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
पात्रों में 4 : 3 और 5 : 2 के  अनुपात में दू ध और पानी का मिश्रण समान मात्रा में है। यदि दोनों पात्रों के  मिश्रण को तीसरे  पात्र में स्थानांतरित कर दिया जाए तो दू ध और पानी का अनुपात कितना हो जाएगा?
Options :
1.  9 : 5
2.  5 : 9
3.  5 : 4
4.  3 : 2
   
Question Number : 62 Question Id : 25498929542 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The incomes of X, Y and Z are in the ratio of 3 : 4 : 5 and the ratio of their respective expenditures is 4 : 5 : 6. If X saves 25% of his income, then the ratio of their savings is:
Options :
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1.  12 : 19 : 26
2.  26 : 19 : 12
3.  26 : 12 : 19
4.  12 : 26 : 19
   
Question Number : 62 Question Id : 25498929542 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
X, Y और Z की आय का अनुपात 3 : 4 : 5 है और उनके  संबंधित व्यय का अनुपात 4 : 5 : 6 है। अगर X अपनी आय का 25% बचाता है, तो उनकी बचत का अनुपात क्या होगा?
Options :
1.  12 : 19 : 26
2.  26 : 19 : 12
3.  26 : 12 : 19
4.  12 : 26 : 19
   
Question Number : 63 Question Id : 25498929614 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In a single throw of three dices, what is the probability of getting a total of at least 5?
Options :

1.  

2.  

3.  

4.  

   
Question Number : 63 Question Id : 25498929614 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
तीन पासों को एक बार फें कने पर कु ल कम से कम 5 आने की प्रायिकता क्या है?
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Options :

1.  

2.  

3.  

4.  

        GENERAL MENTAL ABILITY AND REASONINGSection Id : 2549899935Section Number : 4Section type : OnlineMandatory or Optional :
MandatoryNumber of Questions : 6Number of Questions to be attempted : 6Section Marks : 6Display Number Panel : YesMaximum Instruction Time : 0Sub-Section Number : 1Sub-
Section Id : 2549899976Question Shuffling Allowed : YesIs Section Default? : No    
Question Number : 64 Question Id : 25498910156 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Major' is related to 'Lieutenant' in the same way as 'Squadron Leader' is related to '__________'.
Options :
1.  Flying Officer
2.  Group Caption
3.  Flying Attendant
4.  Pilot Officer
   
Question Number : 64 Question Id : 25498910156 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
'मेजर' का 'लेफ़्टिनेंट' से वही संबंध है जो 'स्क्वाड्र न लीडर' का '________' से है।
Options :
1.  फ्लाइंग ऑफिसर
2.  ग्रुप कै प्टन
3.  फ्लाइंग अटेंडेंट
4.  पायलट ऑफिसर
   
Question Number : 65 Question Id : 25498912938 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
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Each of the letters given below has been assigned a unique number. Select the combination of numbers such that the corresponding letters when arranged accordingly will form a meaningful
word.

A E H R K N
1 2 3 4 5 6
Options :
1.  3, 1, 6, 5, 2, 4
2.  4, 1, 5, 3, 2, 6
3.  5, 3, 1, 4, 2, 6
4.  6, 1, 5, 3, 4, 2
   
Question Number : 65 Question Id : 25498912938 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
नीचे दिए गए प्रत्येक अक्षर को एक विशिष्ट संख्या निर्दि ष्‍ट की गई है। संख्याओं के  ऐसे संयोजन का चयन करें  जिससे संगत अक्षरों को तदनुसार व्यवस्थित करने पर एक सार्थक शब्द बन जाए।
 
A E H R K N
1 2 3 4 5 6
Options :
1.  3, 1, 6, 5, 2, 4
2.  4, 1, 5, 3, 2, 6
3.  5, 3, 1, 4, 2, 6
4.  6, 1, 5, 3, 4, 2
   
Question Number : 66 Question Id : 25498919009 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Select the word from the options that is similar to the given set of words and hence belongs to the same group.

Daisy : Pansy : Rose
Options :
1.  Violet
2.  Garden
3.  Tree
4.  Red
   
Question Number : 66 Question Id : 25498919009 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
विकल्पों में से वह शब्द चुनिए जो दिए गए शब्दों के  समूह के  समान है और इसलिए उसी समूह से संबंधित है।

डेज़ी : पैन्सी : गुलाब
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Options :
1.  बैंगनी
2.  बगीचा
3.  वृक्ष

4.  लाल
   
Question Number : 67 Question Id : 25498919625 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Select the most appropriate description about the given set of words.

Stirrup : Anvil : Drum
Options :
1.  They are parts of the ear.
2.  They are used by riders.
3.  They are musical instruments.
4.  They are used by folk artists.
   
Question Number : 67 Question Id : 25498919625 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्न शब्द समूह का सही विवरण करने वाले विकल्प का चयन कीजिए।

स्टिरप : ऐन्विल : ड्र म
Options :
1.  ये कान के  भाग हैं
2.  इनका उपयोग सवार द्वारा किया जाता है
3.  ये संगीत वाद्ययंत्र हैं
4.  इनका उपयोग लोक कलाकारों द्वारा किया जाता है
   
Question Number : 68 Question Id : 25498919763 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Select the option that is true regarding the following two statements labelled Assertion (A) and Reason (R).

Assertion (A): Indian President is the head of the State.
Reason (R): Indian Parliament consists of President, Lok Sabha and Rajya Sabha.
Options :
1.  Both A and R are true but R is not the correct explanation of A.
2.  Both A and R are true and R is the correct explanation of A.
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3.  A is true but R is false.
4.  A is false but R is true.
   
Question Number : 68 Question Id : 25498919763 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
उस विकल्प का चयन कीजिए जो अभिकथन (A) और कारण (R) नामक निम्नलिखित दो कथनों के  संबंध में सत्य है।

अभिकथन (A): भारतीय राष्ट्र पति राज्य का प्रमुख होता है।
कारण (R): भारतीय संसद में राष्ट्र पति, लोकसभा और राज्य सभा शामिल होते हैं।
Options :
1.  A और R दोनों सत्य हैं परंतु R, A का सही स्पष्टीकरण नहीं  है।
2.  A और R दोनों सत्य हैं और R, A का सही स्पष्टीकरण है।
3.  A सत्य है परंतु R असत्य है।
4.  A असत्य है परंतु R सत्य है।
   
Question Number : 69 Question Id : 25498927397 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0

Options :

1.  
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2.  

3.  

4.  

   
Question Number : 69 Question Id : 25498927397 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
उस विकल्‍प का चयन करें  जो नीचे प्रदर्शित चित्र के  अनुसार बिंदुओं के  स्थान-निर्धारण की समान शर्तों को पूर्ण करता है।

Options :

1.  
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2.  

3.  

4.  

        GENERAL AWARENESSSection Id : 2549899936Section Number : 5Section type : OnlineMandatory or Optional : MandatoryNumber of Questions : 6Number of
Questions to be attempted : 6Section Marks : 6Display Number Panel : YesMaximum Instruction Time : 0Sub-Section Number : 1Sub-Section Id : 2549899977Question Shuffling
Allowed : YesIs Section Default? : No    
Question Number : 70 Question Id : 2549895304 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The monsoons start retreating from Punjab Plains by:
Options :
1.  mid-September
2.  mid-July
3.  mid-October
4.  December end
   
Question Number : 70 Question Id : 2549895304 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
पंजाब के  मैदानों से मानसून की वापसी कब शुरू हो जाती है?
Options :
1.  मध्य सितंबर से

2.  मध्य जुलाई से
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3.  मध्य अक्टू बर से

4.  दिसंबर के  अंत से
   
Question Number : 71 Question Id : 25498912562 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Transboundary pollution or acid rain is caused by:
Options :
1.  nitrogen oxide and sulphur dioxide
2.  carbon monoxide
3.  carbon dioxide
4.  hydrocarbon
   
Question Number : 71 Question Id : 25498912562 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
सीमापार प्रदू षण या अम्लीय वर्षा का कारण कौन-सा है?
Options :
1.  नाइट्रो जन ऑक्साइड और सल्फर डाइऑक्साइड

2.  कार्बन मोनोऑक्साइड

3.  कार्बन डाइऑक्साइड

4.  हाइड्रो कार्बन
   
Question Number : 72 Question Id : 25498912609 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Under optional conditions, the fruit fly (Drosophilae) is capable of producing a new generation every two weeks. This ability is referred to as the ______ of the species.
Options :
1.  biotic potential
2.  carrying capacity
3.  niche
4.  optimal yield
   
Question Number : 72 Question Id : 25498912609 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
वैकल्पिक परिस्थितियों में, फल मक्खी (ड्रो सोफिला) हर दो सप्ताह में एक नई पीढ़ी उत्‍पन्‍न करने में सक्षम होती है। इस क्षमता को प्रजाति की ______ के  रूप में संदर्भित किया जाता है।
Options :
1.  जैविक क्षमता (biotic potential)

2.  वहन क्षमता (carrying capacity)

TypingWale  ·  Type karo. Seekho. Exam clear karo. Hindi Typing Software

  Free Try karo  ·  typingwale.com  

Follow us on:
YT X FB IG WA

https://typingwale.com/?utm_source=CPCT&utm_medium=CPCT+PDF&utm_campaign=CPCT+PYQ+Paper
https://www.youtube.com/@CPCTwale
https://x.com/CPCTwale
https://www.facebook.com/cpctwale
https://www.instagram.com/cpctwale/
https://whatsapp.com/channel/0029Vb76AhmAu3aOqnzcYE0y
https://typingwale.com/?utm_source=CPCT&utm_medium=CPCT+PDF&utm_campaign=CPCT+PYQ+Paper


3.  नीश (niche)

4.  इष्टतम उपज (optimal yield)
   
Question Number : 73 Question Id : 25498922858 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Star fish is grouped under the phylum:
Options :
1.  Echinodermata
2.  Mollusca
3.  Fishes
4.  Arthropoda
   
Question Number : 73 Question Id : 25498922858 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
तारा मछली को निम्नलिखित में से किस संघ के  अंतर्गत वर्गीकृ त किया गया है?
Options :
1.  एकाइनोडर्मेटा

2.  मोलस्का

3.  मत्‍स्य

4.  आर्थ्रोपोडा
   
Question Number : 74 Question Id : 25498932470 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Where did Baba Ram Chandra organise the farmers in the 1920s?
Options :
1.  Awadh
2.  Bihar
3.  Bengal
4.  Andhra Pradesh
   
Question Number : 74 Question Id : 25498932470 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
1920 के  दशक में बाबा राम चन्द्र ने किसानों को कहां संगठित किया?
Options :
1.  अवध

2.  बिहार
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3.  बंगाल

4.  आंध्र प्रदेश
   
Question Number : 75 Question Id : 25498932587 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following Articles of the Constitution of India guarantees freedom to press?
Options :
1.  Article 19
2.  Article 16
3.  Article 22
4.  Article 31
   
Question Number : 75 Question Id : 25498932587 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
भारतीय संविधान का निम्नलिखित में से कौन सा अनुच्छे द प्रेस की स्वतंत्रता की गारंटी देता है?
Options :
1.  अनुच्छे द 19

2.  अनुच्छे द 16

3.  अनुच्छे द 22

4.  अनुच्छे द 31

        English MockGroup Number : 2Group Id : 2549896139Group Maximum Duration : 5Group Minimum Duration : 5Show Attended Group? : NoEdit Attended Group? :

NoBreak time : 1Mandatory Break time : YesGroup Marks : 0         English MockSection Id : 2549899937Section Number : 1Section type : Typing TestMandatory or Optional :
MandatoryNumber of Questions : 1Number of Questions to be attempted : 1Section Marks : 0Display Number Panel : YesMaximum Instruction Time : 0Sub-Section Number : 1Sub-
Section Id : 2549899978Question Shuffling Allowed : NoIs Section Default? : Yes    
Question Number : 76 Question Id : 25498946268 Question Type : TYPING TEST Display Question Number : Yes Calculator : None
Summer camps are supervised camps conducted to entertain as well as equip students with various life skills such as teamwork, socializing, decision making, independent and
responsible living and more. It aids the overall development of a child and children have fun during this process as they get to explore new arenas.
Restricted/ Unrestricted : Unrestricted
Paragraph Display : Yes
Keyboard Layout : Inscript
Show Details Panel : Yes
Show Error Count : Yes
Highlight Correct or Incorrect Words : Yes
Allow Back Space : Yes
Show Back Space Count : Yes

        English ActualGroup Number : 3Group Id : 2549896140Group Maximum Duration : 15Group Minimum Duration : 15Show Attended Group? : NoEdit Attended Group?

: NoBreak time : 3Mandatory Break time : YesGroup Marks : 0         English Typing TestSection Id : 2549899938Section Number : 1Section type : Typing TestMandatory or
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Optional : MandatoryNumber of Questions : 1Number of Questions to be attempted : 1Section Marks : 0Display Number Panel : YesMaximum Instruction Time : 0Sub-Section
Number : 1Sub-Section Id : 2549899979Question Shuffling Allowed : NoIs Section Default? : Yes    
Question Number : 77 Question Id : 25498943005 Question Type : TYPING TEST Display Question Number : Yes Calculator : None
Winter has been my favourite season due to some exciting reasons. Winter vacation is one of them. This vacation is not long like summer vacation but it is quite interesting. In this
winter vacation most of the times we need to remain busy with study for the upcoming final examination. I love winter vacation a lot. There are so many reasons behind this. The
biggest reason is I find so much relief and refreshment from my boring and busy life. There is a really tight school schedule that I need to follow. That is why I do not have enough
time to spend with my cousins or grandma. Winter vacation let me have some extra time and enjoy with the entire family. Here I am going to share my experience of the last vacation
that I have finished a couple of weeks ago. That was amazing and unforgettable. I have to prepare for my upcoming final exam. That is why I made a study routine and took a few
books with me. That routine helped me complete the syllabus and I was pretty much succeeding to follow the routine during the vacation. The whole credit goes to my mom. She was
really strict about my study. In the last vacation our whole family went for a family trip. My uncles and cousins and aunties and grandma came to our house. We spend two days
together. And then we leave for a family trip. Our destination was about three hundred kilometres away from our house. My father booked a resort for us. We reached there with our
own car and entered into the resort. The resort was amazing. I always love the nature view. It was near a big tea estate. A few minute walking distances there is a beautiful big hilly
river. The place was like a dream to me. I was really exciting. There were some amazing little family events. We stayed there for two days. We had a party on the final night together.
The resort manages everything for us. Grandma came out with us and we drive a little away from the resort. We did a little picnic on our own. That was amazing. We took a camera
and food with us. We walked into the small river and get wet. The river was very tiny but the water was really cold and clean. Hilly rivers are full of rocks that I love most. The rocks
were really beautiful and there were lots of colourful rocks. Meeting with my cousins was the most important part of the vacation. We all are students and need to stay the busy
whole year. We do not get enough opportunity to meet each other. This winter vacation let us be everyone together. I think my cousins are my best friends. We are lots of cousins and
pretty much at the same age. We love spending time together. On this vacation when we were staying in a resort we went for a picnic in our own. That was an impressive experience
for me. We all were excited. That vacation was really amazing that I would not forget ever in my life. Especially the family trip was the most interesting part of the vacation. Our
entire family never enjoyed that much together ever.
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एक बार की बात है, अकबर और बीरबल शिकार पर जा रहे थे। अभी कु छ समय की उन्हें एक हिरण दिखा। जल्दबाजी में तीर निकालते हुए अकबर अपने हाथ पर घाव लगा बैठा। अब हालात कु छ
ऐसे थे की अकबर बहुत दर्द में था और गुस्से में भी।
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हजारों  साल पहले के  ग्रंथों  में से ज्ञात हुआ है कि भगवान ने हमसे पहले संसार की रचना की होगी और फिर इसे बनाया होगा अगर यह बात सच है तो इसका मतलब हमारा सौरमंडल अपने आप
वजूद में नहीं  आ सकता था। इसलिये इसे किसी मकसद के  साथ बनाया गया होगा। धरती पर जीवन को मुमकिन बनाने के  लिए जो जो किया गया होगा उन सबकी कु छ ना कु छ इतिहास में
प्रमाणिकता रखी गयी होगी और वह प्रमाणिकता हजारों  साल पुरानी होगी। उसमें से एक प्रमाण बाइबल का भी है। उसके  मुताबिक एक समय ऐसा था जब हमारी धरती बेडौल और सुनसान थी
उसमें ना कोई महादवीप था ना कोई जमीन। परंतु इस ग्रह में अगर जीवन के  लिए जरूरी है तो वह है पानी। जो की इस ग्रह में था इस प्रकार हमारा सौरमंडल कई वजह से पूरी दुनिया में अनोखा है
हमारी आकाशगंगा कुं डली की है और इसी संरचना की दो भुजाओं के  बीच जहां बहुत कम तारे  हैं उसमे हमारा सौरमंडल पाया जाता है। सौरमंडल एक ऐसा मंडल है जो कि ग्रेविटी बल के  कारण
एक दू सरे  छोटे तारों  या कु छ बाकी ग्रहों  के  इधर उधर परिक्रमा करते हैं और सौरमंडल में सूरज और उसमें कु छ खगोलीय पिंड शामिल होते है उसके  अंदर बाकी तारे  ग्रह है। उपग्रह और खगोलीय
दू री और हमारा सूरज यह सब चीजें मिलकर हमारे  सौरमंडल का रचना करती है। और इसके  अलावा सौरमंडल और भी बाकी पिंडो से मिलकर बना होता है। सबसे पहले निकोलस कोपरनिकस ने
खोजा कि सूरज दुनिया का सेंटर है और गणितीय अनुमान लगाने से हेलिओसेनिक प्रणाली को डेवलप करने वाले पहले इंसान में गैलीलियो गैलीली और जान के पलर ने पता लगाया कि ग्रह सूरज के
चारों  ओर घूमते है। सौर प्रणाली अक्षर पहली बार अंग्रेजी में प्रकाशित किया। गैलीलियो गैलीली की खोज से ही हजेंस ने सेंटर के  चांद टाइटन और शनि के  चारों  ओर छलले की खोज की। जियोवानी
डोमिनिको कै सीनी ने शनि के  चार और उपग्रह की खोज की और बायनरी तारे  की तलाश में थे जब उसने नया धूमके तु देखा था। इसकी कक्ष से पता चला कि यह एक नया ग्रह यूरेनस था। इस प्रकार
सौरमंडल में अनगिनत तारे  और ग्रह है। इसकी खोज कई वैज्ञानिकों  ने की और सफल भी रहे और नई नई खोजो में आज भी तैयार है। हमारे  सौरमंडल में ग्रहों  की गिनती है और इन ग्रहों  को दो दो
भागों  में बांटा गया है। पहला आंतरिक ग्रह और दू सरा बाहरी ग्रह। उनकी गिनती हजारों  लाखों  में है। धूमके तु को पूछल तारा भी कहते है। इसका कारण इसके  पीछे  एक छोटी सी चमकदार पूछ
होती है और धूमके तु रोडी और आइस और गैस से बने होते हैं जो सूरज की परिक्रमा करते हैं। हमारी आकाश गंगा में अनगिनत तारे  मौजूद है इनमें से एक सूरज भी है। हमारा सौरमंडल बहुत ही
विशाल है। यहां अनगिनत तारे  और ग्रह हैं इसे पूरी तरह से जानना या खोजना अभी संभव नहीं  हो पाया है। सालों  से पूरी दुनिया के  खगोल वैज्ञानिक सौरमंडल के  राज को उजागर करने में कठिन
परिश्रम कर रहे हैं तथा दिन प्रतिदिन नए नए खगोलीय पहलुओं को हल कर हमारे  सौरमंडल के  बारे  में नित नई जानकारी हमें दिलाते हैं आने वाले दिनों  में हमें इस सौरमंडल के  बारे  में कई जरूरी
और रोचक जानकारियां एवं खोज के  बारे  में सूचना मिलेगी हम यहीं  आशा करते है।
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